Manual For Using the NetBeans IDE

The content of this document is designed to help you to understand and
to use the NetBeans IDE for your Java programming assignments. This
is only an introductory presentation, and is no way intended for any
professional or commercial use. It is geared especially for those students

who have little or no knowledge of NetBeans and its use.
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Download JDK(SDK) and NetBeans

In order to compile and execute your Java program, you need the Java compiler, first and foremost.
You can download it from the web at oracle.com at no cost to you. Secondly you will need an editor
which will use to compose the program. We have chosen the program NetBeans, though other
programs such JCreator could.
NetBeans is more than Just an editor. It is what is called an Integrated Development

Environment (IDE, as it is popularly called) is a suite of programs that comes packaged as one unit
that enables programmers to develop application software. It comes with a source editor which you
will use to create and edit the program that is being developed; a translator which compiles, executes

the program; and, a debugger that helps to test and track errors in the program.

Go to the netbeans website at: http://netbeans.org/downloads/
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Locate NetBeans

Figure 1 shows a screen shot of my desktop. The last icon in the row of icons represents the
NetBeans program. Locate it on your screen and point the mouse on it.
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Figure 1 Locate the NetBean icon.

Load NetBeans

Once you have located the NetBeans icon by placing your point on it, double click on the icon
to load NetBeans. Waite a while and you’ll observe the NetBeans screen appears. It looks
similar to Figure 2.




In its setting up, your will see a window appears, with a small window inset — similar to Figure 3.
Inside the small window you will notice a slider moving across. This is indicating that the
NetBeans program is still being loaded into the memory of your computer. Wait ....
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Figure 3 NetBeans is Being Loaded.

Once NetBeans is loaded the smaller window disappears and the larger one remains. Your
screen should look similar to Figure 4. This is the window that you will be using to:

(a) Type/edit your Java program.

(b) Compile your program, and

(c) Execute your program.
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Figure 4 The NetBeans Environment



Navigating The NetBeans Window.

Referring to Figure 4 notice that the screen is divided into various areas. There are three (3)

rows of information and three sub screens/windows.

The first row tells us among other things, the name of the Program. In this case NetBeans IDE
4.1 (Yours might be an updated version say 5.10 or so).

The second row is a menu showing the different tasks that you can perform. The first option is
File. Click on it and you will see as in Figure 5 the different options for handling your Java
program file(s).
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Figure 5. The File Menu.

The File menu allows you, among other things, to:

(a) Create a new project (directories in which to store your Java files)
(b) Create a new Java source file; or

(c) Open an existing project, or

(d) Open an existing Java file.

If you slide the mouse across the menu, to Edit and click on it, you will see the activities (in
grey) that can be done when editing a Java file. See Figure 6.
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Figure 6 The Edit menu

Chief among the activities that you can perform are:
(a) Copy a piece of text, and
(b) Paste a piece of text that was copied.

Next, move the mouse over to the menu choice Build. This is another option that you will be
using frequently. See Figure 7. In grey you see the menu item marked Compile File. This is the

option that you will choose when you want to compile your Java program.
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Figure 7 The Build Menu.



Lastly, move the mouse over to the menu choice mark Run. See Figure 8.
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Figure 8 The Run menu.

This is the option that you will use when you want to execute your Java program. Point on Run
you will see sub menu Run File. At this point you will not be able to see anything more since we
do not have an active file to run.

The third row of menu choices contains icons for many of the menu choices in the second row.
You may explore these at your own pace. Look back at Figure 4 we see three rectangular
windows. The window marked Projects is the area which shows us the Java files, among other
things, that are in the Project/folder that you are currently working with. The window to the
right of it is where you will compose/edit your Java files; and the window that is marked Output
shows:

(a) The state of your Java program when it is compiling,

(b) The state of it when it is executing (running), and

() Any output generated from your program.

Creating a Project/Folder

Whenever you are about to write a Java program using NetBeans, one of the first things that
NetBeans requires you to do is to create a folder in which to place all the Java files for your
application. NetBeans calls the folder a Project. So you must create a project in which to place
your Java files.

To create a Project do the following:

(a) Select File New Project. You will get a screen similar to Figure 9.
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Figure 9 Creating a new Project.

(b) Using Figure 9, select General = Java Application, and click Next.
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(¢) Go to menu item Project Location. Click on the Browse button, and select the disk drive

and directory where you want your project to be stored. You will get a new window, similar

to Figure 10. When you have decided on the folder where you want to create your project,

click on it, and then click Open. In my case I selected drive D, and directory computer
science 2006. Next click on the Open button to confirm the selection.
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Figure 10. Locating Disk Drive and Directory in which to create Project.
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11
By now you should get a new screen similar to Figure 11. Notice that the Project Location field and

the Project Folder field are filled in for you automatically.

Steps Name and Location

1, Choose Project
2, Name and Location

Project Name: \

Project Location; \D:\tumuulsr sclence 2006 ] ? Bmwuu.

Praject Folderi | Dijcomputer science 20064 |

(V] St as Main Project
[=1£

Project Narme (s not a valid folder name,

Figure 11 Fields are automatically filled in.

(d) Next, in the text field marked Project Name, ignore whatever the default name is and type
your own project name. In my case I call it Understanding NetBeans. See Figure 12.
Notice that NetBeans fill in your project name at the field Project Folder also.

% New Java Application

Steps Name and Location

1. Choose Project
2. Name and Location

Project Name: | Understaning MNetBeans|

Project Location: \ D:\computer science 2006

Project Folder: | Diicomputer science 2006\Understaning NetBeans

Set as Main Project

Create Main Class | understaningnetbeans. Main
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Figure 12 Filling in Project Name

(e) Because you want to have control over the things that you do in your Project, uncheck the
selections marked:

e Set as Main Project, and

e Create Main class

See Figure 13.

U Mew Java Application

steps Name and Location

1. Choose Profect Profect Name: | Unelarstaning Nettisans

Profect Location! | Br\computer science 2006 \ [ Browse, .,

Project Folder| ' Di\computer sclence 2006\Understaning NetBeans ‘

2, Name and Location

[ ] Set as Main Profect

[" 7F|Anl5-':|7‘]( Cancel ]l Ielp ]

Figure 13 Uncheck items Set as Main Project and Create Main Class

(f) Click the button marked Finish. Wait a while. You should have a screen similar to Figure 14.
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Figure 14 The Project has been Created.

Creating a Java File

To create a java program file do the following
(a) Using Figure 14, select > File > New File. Sce Figure 15.

”15’..7 NetBeans IDE 4.1 [:|@®

Edit View Build Run Refactor Versioning Tools Window Help

I[® Mew Project... Ctrl+Shift+M | = (= /‘;‘ @ @ “:*D “D D}

By new File... Cerl+N

[ Open Project... Ctrl+Shift+0O
Open File... Ctrl+O
Open Recent Project

Close Project

Set Main Project

Project Properties

Save

‘ﬁ Save all

Refresh All Files

Page Setup...

Print...

Print to HTML. .,

Exit

Figure 15 Creating a Java File.

(b) On the new window, Figure 15, sclect Categories: Java Classes and File Types: Empty
Java File. See Figure 16, and click the Next button.
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Figure 16 Selecting File Category and File Type.

(c) Enter the name of the java class file you wish to develop, and press the Finish button. You
should see a screen similar to Figure 17. In my case I name the file Book. NetBeans will
automatically append .java to the name of the file you supplied. In this case, Book.java.

% New Java Main Class

Steps Name and Location

1. Choose File Type Class Name: | Book| ‘

2. Name and Location
Project: I Understaning NetBeans ]
Location: | Source Packages v ‘
Package: [ v J‘

Created File: E D:icomputer science 2006{Understaning NetBeans!srciBook.java ‘

‘Warning: As of JDK 1.4, it is highly recommended that you do NOT place Java classes in the default package.

Figure 17. Namethe Java file Book

(d) This empty window Figure 18 is the window in which you will type a single Java class file.
There is another way to create a new window, but stick with this format for now.
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Figure 18 An empty window in which to type a single Java file.

(e) Type the definition for the class called Book.java. In this exercise a book has a title, the
isbn, and a price associated with it. See Figure 19.
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Figure 19 Typing the Java file called Book.

Compiling a Java File
Go to the menu in the second row of the NetBeans window and select Build = Compile

Book.java. See Figure 20.
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Figure 20. Locating the Compile option.

When you click on this option, you are submitting your Java program to the Java compiler to compile

your class (Book.java) in this case. If the program is compiled successfully the window marked

Output should be similar to Figure 21.
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Figure 21. Compiling Java program file Book.java successfully

Creating A Test Class

Our next task it to write the test class. Select the option File = New File.

call my new class TestBook. See Figure 22.
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Figure 22 Writing a Test class.
Next, compile the code for TestBook.java. Follow similar steps as in the previous case for the class
Book.java.

Executing a Java File

You can only run a program that has a main method, like class Test.java. To run you program select

Run = Run File 2 Run TestBook.java. On doing so, you should get a screen similar to Figure
23.
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Figure 23 Locating the option to Run/Execute a Java program.

After you have clicked on the option your screen should look similar to Figure 24.
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Figure 24. The result of Executing the Program.

Once this is done, the program runs, you get an output similar to what you see in the window
marked Output of Figure 24.

See the exercise at the end of this manual. Create a workspace called test01, type the two classes in
the same folder but store them in separate files - Book.java and TestBook.java. Compile
Book.java first, then TestBook.java. Execute TestBook.java, both files will be executed.

Exercises

1. Type the following source code and save it in a file called Book.java

public class Book
{

ptivate String name, isbn;
private double price;

public Book(String n, String isb, double cost)
{

name = n;
isbn = isb;
price = cost;

public String getName()
{

return name;

public String getlsbn()
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return isbn;

public double getPrice()
{

return price;

2. Compile the code
3. Type the following source code and save it in a file called TestBook.java

public class TestBook
{

public static void main(String arg]])
{
Book b = new Book("High Road To Programming", "100-00-999",
125.50);

System.out.println();

System.out.println("Name of book: " + b.getName());
System.out.println("The ISBN is : " + b.getIsbn());
System.out.println("The price is : $" + b.getPrice());
System.out.println();

4.  Compile the code
5. Execute the program
6. Show result to your lab instructor.

The End
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